
MALDI Tofspec-2E User’s Booklet 
 

If you have questions or problems while using this instrument, please contact Jim Windak, phone # 647-
2847, e-mail jwindak@umich.edu
 

I. How to Get Started – Basic Operation in Reflectron Mode 
 

1) Turn on the power switch for the camera monitor. 

 
 

Power Switch  

2) Turn on the light source for the microscope camera. 

 
 

Power Switch for Light Source  

3) Log on with your username & password. 

 
 

4) After you log on, the MassLynx software will automatically start.  Near the bottom of 
the page, you will see a message “Connecting to Instrument”.  After 20 seconds, you 
should see the message “Running MALDI-TOF” if everything is working properly. 

mailto:jwindak@umich.edu


This is the MassLynx 
Window   

Running MALDI-TOF message  
appears after 20 seconds. 

 

 

Connecting to 
Instrument message 
 
 

5) A Tune Page will automatically open.  When you see the button labeled 

 on the Windows task bar at the bottom of the screen, do not 
do anything else.  Please wait for it to finish initializing the instrument. 

 
 

This is a Tune Page  

 is on the Task 
Bar.  Do not do anything else while this is 
present. 

 

6) After the Tof-2 Process Manager is finished, and after it has disappeared from the 
Windows task bar, then you can open your instrument parameter file.  Do this by 
clicking on File and Open, and browse to the parameter file you want to use, and then 
click on OK.  This will then automatically set up all of the instrument parameters for 
your data acquisition. 

 
7) If you wish to view or change any of your instrument parameters, click on the Mode 

menu, and then click on “Display Instrument Parameters”. 

 
 
 



Typical Instrument Parameters for Reflectron Mode: 

 
 

If you want to change a parameter, such as the Mass Range, you must highlight the parameter 
value, type in the new value that you want, and then press the Enter key on the computer 
keyboard.  (Please Note!  The parameter will not change unless you press the Enter key). 
 
If you change the Mass Range, you need to update the mass range on the spectrum 
window.  To do this:  Right-click the mouse in the spectrum window.  A menu will 
appear.  Left-click on initialize. 
 
8) Usually, a Pulse Voltage in the range of 2200 to2400 works well for peptides in 

Reflectron mode.  However, you may need to optimize the pulse voltage to get the 
best mass resolution.  The optimal value for the pulse voltage is mass dependant.  For 
example, the best pulse voltage to use for m/z 2465 is not the best value to use for 
m/z 5730. 

 
Please note:  Once you optimize the pulse voltage, you should always use the same value 
for running calibration standards and samples.  Changing the pulse voltage will shift 
the mass calibration slightly. 



 
Example of optimizing the pulse voltage: 

 

 

Here the Pulse 
Voltage is set 
to 2800.  The 
mass 
resolution at 
m/z 2465 is not 
good. 

 

 

Here the Pulse Voltage is 
set to 2200.  The 
resolution at m/z 2465 is 
good. 

 
9) Click on the Vacuum menu, and click on Monitor to bring up the vacuum pressure 

gauges.  These are typical pressures for the instrument: 

The analyzer 
pressure is 
normally around 
8 X 10-8. 
The source pressure is 
normally around  
8 X 10-7. 
 
If a sample plate has 
recently been loaded, the 
pressure will be higher, 
around 1 X 10-6. 
 
 

10) Check to make sure that the instrument is in STANDBY mode.  There will be a red 
bar visible when the instrument is in STANDBY.  After you are sure it is in 
STANDBY, then you can click on “Unload Probe” to unload the sample probe from 
the instrument. 



 

Always be certain that the 
instrument is in STANDBY (red 
bar) before unloading or loading the 
probe.  After you are sure the 

instrument is in STANDBY, 
then you can click on Unload 
Probe.  

 
 
 
 
11) After the probe has unloaded, the space under the glass cover will be vented to 

atmospheric pressure.  You will know when it is vented because the glass will no 
longer be pressing down on the rubber o-ring. 

 

Glass is shown pressing down 
on the rubber o-ring. A flat 
spot on the o-ring is visible. 

 

 

Glass is not pressing down on 
the o-ring.  No flat spot is 
visible on the o-ring.  This 
means the area under the glass 
is at atmospheric pressure. 

 
12) After the area under the glass has been vented, remove the glass cover by lifting 

straight up with the handles.  Put the glass lid in the holder. 



 
13) Insert your sample plate into the rectangular area, so that it is perfectly flat. 

 

 

Plate is flush against this edge  

 Cutout edge of the sample 
plate goes in this corner. Plate is flush 

against this 
edge  Front of 

Instrument  

 
 
 
 
14) Put the glass cover back on top.  Bring up the vacuum monitor window.  Then click 

on the “Load Probe” button on the Tune page.  First, the air under the glass will be 
pumped away.  When this happens, the Inlet Pirani gauge will go off scale, and then 
slowly come back down as the air is pumped away. 

 

 

The Inlet Pirani goes off 
scale, and then comes back 
down as the air under the glass 
is pumped away. 

 
 Next, the sample probe will slowly open into the high vacuum region inside of the 
instrument.  When this happens, the Source ion gauge will go high, into the red zone, and 
then slowly will come back down. 
 



 

Source ion gauge 
goes high, and 
then slowly comes 
back down. 

 
Please Note!  You must wait until the Source ion gauge reads less than 2 X 
10-6 before putting the instrument into ON mode. 
 
15) After the Source pressure is less than 2 X 10-6, you can click on the ON button to put 

the instrument into ON mode.  The red bar will change color to green. 
 
When the instrument is in 
ON mode, the bar under the 
button is green.  This means 
that the high voltages are 
on.  

 
 

16) To move the sample plate to the spot that you want, type in the letter and number of 
the spot in the “Sample” box, and push the Enter key on the computer keyboard.  You 
will hear the sample probe move the plate to this spot. 

 
 

 Type in the letter and number of the 
spot that you want, and push the Enter 
key on the keyboard. 

 
 
 
 



 
17) To see if you are getting a good signal, you can click on “Fire Laser”, and you will 

see a spectrum on the screen.  You may have to adjust the Laser Coarse and Laser 
Fine power settings in order to get a signal with good intensity.  If the signal is too 
weak, try increasing the laser power.  If the signal is too strong, try decreasing the 
laser power. 

 

 1275 counts is 
the largest signal 
allowed when 
averaging 5 laser 
shots.  These mass 
peaks are off scale 
(too large). 
In this case, the laser 
power should be 
decreased. 

 

 

 Here the 
laser power 
was lowered, 
and now the 
maximum 
counts are 
around 900.  
This is a strong 
signal without 
being too 
strong. 

 
18) After the laser power has been adjusted to give the optimum sized signal, you can 

acquire data by clicking on the Acquire button.  After the Acquire Data File dialog 
box comes up, click on Browse, and then navigate to the folder you want to put the 
data into. 

 

 Click on Browse  

 



 

 Then navigate to the 
“Data” folder in your 
project, and click OK. 

 

 

Then enter a data 
file name here  

Enter a text description 
for your sample here.  
This text will appear on 
the top of your spectrum. 

When you click on OK, it will 
start to acquire data. 

 
 
19) While you are acquiring data, if your signal becomes weak, move to another area of 

the sample spot by clicking and dragging the crosshairs.  When you release the mouse 
button, you will hear the sample probe move to the new area. 

 

Click and drag the crosshairs to a 
new area on the sample spot.  
When you release the mouse 
button, it will move to the new 
area. 

 
20) When you are done acquiring, click on Stop Acquisition, and then click on Yes when 

asked if you really want to stop the acquisition. 



 
II. Analyzing the Data 
 

1) To view your data, go to the MassLynx window, and click on the Chromatogram 
button on the toolbar.  Alternatively, you could click on the View menu, and then 
click on Chromatogram. 

 
 

 
 

 Chromatogram button 

2) In the Chromatogram window, click on File, and “Open…”, then browse to the file 
you want to analyze, and click on OK.   

 
Shortcut Tip: If you want to analyze the most recent file acquired, simply 

click on the  icon on the Chromatogram toolbar.  This will open the last file 
acquired with one click. 
 

3) Click the right mouse button on the chromatogram to display a single mass spectrum.  
If you want to add together several spectra, you can right-click and drag over a range 
of scans on the chromatogram. 

 

 
4) A spectrum window will automatically open displayi

 

 
5) If you want to zoom into a region of the spectrum, le

that region. 
Right-click and drag the 
mouse in the 
chromatogram to add 
together spectra. 
 

ng the scans you have selected. 
Left-click and drag across a 
region of the spectrum if 
you want to zoom in on that 
region 
 

ft-click and drag the mouse over 



 
 

Zoomed in region of 
the spectrum.  

6) To determine the optimal parameters for smoothing and centering the mass peaks, 
you need to determine the number of  “channels” of peak width.  To do this, left-click 
and drag across the center of the peak at half-height, and read at the bottom of the 
spectrum the number of channels. 

 
 
 
 
 

Left-click & drag the mouse pointer 
across the peak at half height  

Read the number of channels here  

7) To smooth the data, click on the Process menu, and Smooth.  The following dialog 
box will come up.  Enter ½ of the number of channels of peak width into the Smooth 
window (channels) parameter.  For example, if your peak is 10 channels wide, then 
set this parameter to 5.  Use 1 smooth, and use the Savitzky-Golay smoothing 
method, and click OK. 

 
 

Spectrum after smoothing: 
 

 
 

8) Perform a baseline subtraction by clicking on the Process menu, and Subtract.  The 
following dialog box appears.  Use a polynomial order of 99 for Reflectron data that 
is well resolved, and click on OK. 



 

 
 

Spectrum after baseline subtraction: 
 

 
 

9) Find the center of each mass peak by clicking on the Process menu, and Center.  The 
following dialog box appears.  Enter ½ of the peak width for the number of channels, 
and use 50% of the centroid top.  Click on OK. 

 

 
 

Spectrum after centering: 
 

 
 
 
 
 



Shortcut tip:  You can do smoothing, baseline subtraction, and centering all in one step, 

by clicking on the icon on the toolbar. The following mass measure dialog box will 
come up, enabling you to enter the parameters for each one in one step: 

 
 

III. How to Calibrate 
 

1) Spot your plate with several standard compounds, and then acquire some spectra. 
 

2) After you have smoothed, subtracted, and centered a spectrum containing your 
calibration standards, you can create a mass calibration curve by clicking on the Tools menu, and 
Calibrate.  You will see a drop-down menu to choose a reference file that contains the m/z values 
of your standards. 

 
 
3) After you click on OK, you will enter the calibration program.  You will see your 
acquired mass spectrum on top, then the reference file mass peaks below it.   First, click on 
the Edit menu, and click on calibration parameters.  Set the polynomial order for curve fitting 
to “1”, if you have 2 or 3 standards in your calibration spectrum.  Set the polynomial order to 
“2”, if you have 4 or 5 standards in your calibration spectrum. 

Choose your reference file here  



 
 
 
 
 
 
 

 
 

  
 
4) To apply this calibration to other data files as an ex
click on File, and Save As to save it.  If you are only us
own data file, then it is not necessary to save it. 
 

Right-click a peak in the reference spectrum, and then rig
acquired spectrum to assign a standard mass to that peak.
standard to be sure that you are assigning the correct isot
the Display menu, and Default. 

This window shows the 
calibration curve.  

 This window shows the residuals, o
peaks and the calibration curve. The li
around 0.01 or 0.02 Dalton for Reflect
 Set the polynomial order 
to “1” for 2 or 3 standards, 
and set it to “2” for 4 or 5 
standards.
 

 

ternal calibration, you will need to 
ing it as an internal calibration on its 

ht click the corresponding peak in the 
  You may need to zoom into each 
ope peak.  To zoom back out, click on 

r differences between the mass 
mits on the graph should be low, 
ron data that is well resolved. 



5) After you have created and, if necessary, saved your calibration curve, you can exit from 
the calibration program.  It will ask you whether you want to accept this calibration.  
Click on Yes. 

 
6) To apply an external calibration to other sample data spectra, you need to click on the 

Tools menu in Spectrum, and click on Apply Calibration.  Then browse to the calibration 
file you want to use, and click on OK.  The m/z scale on the mass spectrum will then be 
adjusted slightly using the calibration curve. 

 
Please note:  It is possible to automatically apply an external calibration curve to 
sample data while it is being acquired.  To do this, click on the Details tab of the 
Acquire dialog box.  Click on the option “Use Cal File”, and browse to select the 
calibration file you want to use.  However, due to a software glitch, the calibration file 
you use must be located in the C:\Masslynx\Cal  folder, and nowhere else. 
 

 
 

 Details tab of the Acquire dialog box. 

Click on the “Use Cal File” 
option, and select an 
external calibration file 
from the C:\Masslynx\Cal 
folder, if you want to enable 
automatic application of an 
external calibration. 

7) Raw data spectra are automatically saved during data acquisition.  However, you can also 
save processed spectra if you want to.  For example, if you combine several scans into 
one spectrum, and then smooth, subtract, and center this spectrum, you can save this 
processed spectrum by clicking on File and Save Spectrum.  If you wish to retrieve this 
spectrum at a later date, click on File in the Spectrum window, and click on Open.  Then 
browse to the file you want, and click on the History button.  Highlight the saved 
spectrum and click on OK to bring it up. 

 
 
 
 
 
 
 
 
 
 
 
 
 



IV. How to shut down when you are finished 
 

1) Put the instrument into Standby mode, so that the red bar is visible. 

 
 

2) Unload the probe, and then remove your sample plate. 
 
3) Reload the probe. 

 
Please note:  You must reload the probe when you are finished.  
Also, you must wait until the probe is completely loaded, and has 
stopped moving, before you exit from the Tune page.  Failure to 
do so will make the probe unusable.  If this happens, then I must 
perform a probe resetting procedure. 
 
4) After the probe has completely loaded, you can exit from the Tune page. 
 
5) Next, exit from Masslynx.  This will log you out of the system. 

 
6) Turn off the light source. 

 

 
 

Turn off the power switch  

7) Turn off the camera monitor. 
 

 
 

Turn off the power 
switch  

8) Backup your data, and then delete it from the hard drive. 



 
How to Switch to Negative Ion Mode 

 
The spectrometer is more likely to arc in negative ion mode than in positive ion mode.  If you need to 
work in negative ion mode, you must switch over slowly and carefully. 
 
Please use the following procedure to switch from positive ion mode to negative ion mode: 
 

1) Put the instrument into Standby so that the red bar is visible. 

 
 

2) Set the Source voltage to 2.5 KV, using the drop down menu.  This is the lowest value for the 
voltage. 

 

Use the drop-down menu to 
select 2.50 KV  

 
3) Set the Polarity to Negative, using the drop-down menu. 
 

 

 Change the Polarity to Negative, 
using the drop-down menu. 

 
4) Put the system into ON mode. 

 

 
 

5) Monitor the vacuum pressures. 



 
6) Slowly increase the Source Voltage in steps of 2.5 KV.   Wait 5 seconds between each step, 

and check the Source vacuum pressure.  Make sure that the Source vacuum pressure does not 
go up.  Surges in Source vacuum pressure indicate arcing of the high voltage.  If the Source 
vacuum pressure is stable, then increase the voltage another step, until the voltage is up to 
20.00 KV.  Do not exceed 20.00KV. 

 

 

 Slowly increase the voltage in steps of 
2.5 KV, until you reach 20.00KV 

 
7) Now you can collect data as you normally do. 

 
8) When you are finished, put the instrument into STANDBY. 

 

 
 

9) Then change the Polarity back to Positive. 
 

 

 Please leave the instrument in 
Postitive ion mode when you are 
done. 

 



How to Operate in Linear Mode 
 

Use linear mode for analyzing larger molecules that have a molecular weight greater than 6000.  
Linear mode is well suited for intact proteins, large polymers, dendrimers, and oligonucleotides. 
 
1) After Masslynx and the Tune page come up, and after the Tof-2 Process Manager has 

disappeared from the Windows task bar, you can load your linear parameter file.  Click on File 
and Open, and select the parameter file you want to use, and click on OK.  Here are some typical 
linear parameters: 

 

 
 

2) When reading in your linear parameter file, the software usually clips the upper mass range to a 
little over 12000.  If you need to increase the mass range, highlight the Mass Range parameter, 
and then type in the number that you want, and push the Enter key on the computer keyboard.  
(Please note: The parameter will not be changed unless you push the Enter key).  To change the 
mass range on the spectrum window, right-click the mouse in the window.  A menu will appear.  
Left-click on Initialize.  This will update the mass range. 

 
3) You will probably need to use a Laser Coarse setting of 50% or 100%, and a laser fine greater 
than 50, in order to get a strong enough signal.  
 
4) You may need to adjust the Pulse Voltage to get the smallest peak width possible.  The optimal 

value for the Pulse Voltage is mass dependant.  For example, the ideal pulse voltage for m/z 
60,000 is different than the optimal pulse voltage for m/z 12,000.   

 
 
Please Note:  Once you have set the pulse voltage, you must use the same pulse 
voltage for both calibration standards and samples.  Changing the pulse voltage 
will shift the mass scale slightly. 

 
 



Example of optimizing the Pulse Voltage to get the narrowest mass peak: 
 

 

Here, the Pulse Voltage is set to 1800.  The 
mass peak at m/z 12360 is too wide. 

 

 

Here the Pulse 
Voltage is set to 
1200.  The mass 
peak at m/z 12360 is 
narrower. 

 
5) You will need to use different parameters for smoothing, subtracting and centering, than what are 

used for reflectron data.  For smoothing, you should use the mean smoothing algorithm, and 6 or 
more channels, and 3 or more smooths. 

                                               

   
 
 
 
 

Spectrum before smoothing: 

 



 
Spectrum after smoothing: 

 
 

6) For baseline subtraction, use a polynomial order of 15. 
 

 
 

Spectrum after subtraction: 

 
 

7) For centering, use a large value for channels, such as 20, so that the peak will not be broken up 
into several peaks. 

 
 
 



 
Spectrum after centering: 

 
 

8) To calibrate, run a spectrum of known standards.  For protein work, the standards that are often 
used are Cytochrome-C (m/z 12360), Myoglobin (m/z 16951), and Trypsinogen (m/z 23980) in a 
sinapinic acid matrix.  After the spectrum has been smoothed, subtracted and centered, click on 
the Tools menu, and Calibrate.  A drop-down menu will appear, allowing you to select a mass 
reference file.  After you select a reference file and click on OK, you will enter the Calibration 
program. 

 

Right-click each peak in the 
reference spectrum, and then 
right-click the corresponding 
peak in the acquired mass 
spectrum to assign an m/z 
value to each peak. 

This is the calibration 
curve. 

 
 

 

These are the residuals, or the 
difference between the points and 
the curve.  The residuals should 
be less than 2 Daltons.
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